
HP OpenView Smart Plug-in for BEA WebLogic 
Server 
for the HP-UX and Solaris OpenView Operations Management Servers 

Release Notes 
Software version: A.04.00 /February 2007 

This document provides an overview of the changes made to HP OpenView Smart Plug-in for BEA WebLogic 
Server (WLS-SPI) for A.04.00. It contains important information not included in the manuals or in online 
help. 
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• Enhancements and Fixes 

• Known Problems, Limitations, and Workarounds 

• Support 

• Legal Notices 

In This Version 

A.04.00 

This release of WLS-SPI fixes a number of bugs and adds the following capability:  

• Support of WebLogic Server version 9 

• View WebLogic Servers  application: displays the WebLogic domain configuration, cluster information, 
and physical machines 

• View Applications  application: displays the names and versions of all applications deployed on a 
WebLogic Server instance 

• Metrics updated to support WebLogic Server version 9 

⎯ metrics 10 – 12: WebLogic Server version 9 uses a single thread pool and only a single execute queue 
⎯ metric 15: the MBean attribute ExpectedToRun no longer exists in WebLogic Server version 9 
⎯ metric 240: the ASCII report now includes the URL and invocation rate 
⎯ metric 251: the ASCII report now includes the health state for JMS servers, message pending count 

for JMS destinations, and bytes pending count for JMS destinations 
⎯ metric 270: the ASCII report now includes the current status of inbound connections 

• New XML cache and time service metrics for WebLogic Server version 9, including the number of 
deferred requests, thread request wait time, number of pending requests, percentage of pending 
requests, maximum time a request waits for a thread, and number of threads in the standby pool 

• HTTPS agents on UNIX platforms (HP-UX, Solaris, Linux, and AIX) running as non-root to promote a 
more secure operating environment 
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Documentation Updates 

The first page of this release notes document contains the following identifying information: 

oftware version. 

e the document is updated. 

llowing URL: 

• Version number, which indicates the s

• Publish date, which changes each tim

To check for recent updates or to verify that you are using the most recent edition, visit the fo

http://ovweb.external.hp.com/lpe/doc_serv/ 

1 In the Product list, click the product name.  

2 In the Version list, click the version number.  

3 In the OS list, click the OS type.  

4 In the document list, click the document title.  

ad.  

NOTE: ), Adobe Acrobat Reader must be installed on your system. To 
dow  

http://www.a

5 To retrieve the document, click Open or Downlo

 To view files in PDF format (*.pdf
nload Adobe Acrobat Reader, go to the following URL: 

dobe.com

Installation Instructions 

Installation information for the HP OpenView Smart Plug-in for BEA WebLogic Server can be found in the 
ogic Server Configuration Guide. 

Software Requirements 

o view service maps, Service 
Navigator must be installed. 

n in bold and red 

Supported Versions 

HP OpenView Smart Plug-in for BEA WebL

Service Navigator is not required to run the WLS-SPI. However, if you want t

NOTE: New platforms are show

Management Servers 

Component 

HP OpenView Operations for UNIX 7.1, 8.1, 8.2 
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Managed Nodes 

Component Supported Versions 

WebLogic Application Server 6.1 sp7+ 1 HP-UX 11.00, 11.11 
HP Tru64 5.1A, 5.1B 
Solaris 2.6, 7, 8, 9 
Windows 2000, 2003  
Suse Linux ES 7, 8 
AIX 4.3.3, 5,1, 5,2 

WebLogic Application Server 7.0 HP-UX 11.00, 11.11 
HP Tru64 5.1A, 5.1B 
Solaris 7, 8, 9 
Windows 2000, 2003  
Red Hat Linux AS 2.1 
Suse Linux ES 7, 8 
AIX 4.3.3, 5,1, 5,2 

WebLogic Application Server 8.1 sp1, sp2, sp3, sp4, sp5 HP-UX 11.00, 11.11, 11.23  
HP Tru64 5.1A, 5.1B 
Solaris 8, 9 
Windows 2000, 2003  
Red Hat Linux AS 2.1, 3.0 
Suse Linux ES 8, 9 
AIX 5,1, 5,2, 5.3 

WebLogic Application Server 9 HP-UX 11i, 11.23  
Solaris 8, 9, 10 
Windows 2000, 2003 
Red Hat Linux AS 3.0, 4.02

HP OpenView Performance Agent  (UNIX or Windows) C.03.00+ 

HP OpenView Reporter A.03+ 

HP OpenView Performance Insight 5.0, 5.1 

HP OpenView Performance Manager (HP-UX, Solaris, 
Windows) 

4.x, 5.x 

 
1 Service pack sp7 or greater must be installed on WLS 6.1. WLS-SPI only supports WLS 6.1 with service pack 7 
or greater installed. 

2 For managed nodes running Red Hat Linux AS 4.0, in order for discovery to successfully update the service 
maps, upgrade to the latest version of Red Hat’s glibc library. 

Installation Requirements in a Non-Root HTTPS Agent Environment 

If you are running or planning to run a non-root HTTPS agent on a UNIX managed node (OVO 8.x only), you 
must install the OS-dependent Sudo software package on that UNIX managed node. Sudo is free software 
available from http://www.sudo.ws. The OS-dependent software packages are available at the bottom of the 
download page (http://www.sudo.ws/sudo/download.html). 
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Enhancements and Fixes 
The following items (identified by error tracking number) are fixed in the current software release.  More 
detailed information about enhancements and fixes can be found online at the HP Online Software Support 
web site. The first time you visit this site, you must enter your HP passport information. To set up your 
passport profile, go to: http://support.openview.hp.com/support.jsp?fromOV=true. 

Enhancements with Version A.4.00 

CR NUMBER DESCRIPTION 

QXCR1000136510 Change OVPM integration to have graphs show up in GUI. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000136510

QXCR1000199942 WebLogic SPI support for AIX managed nodes. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000199942

QXCR1000135486  WebLogic and WebSphere collector runs are resource intensive, need to improve. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000135486

QXCR1000217921 Add SSL support to discovery for WebLogic. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000217921

QXCR1000157743  WLSSPI-0011.1 execute threads too high critical message. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000157743

QXCR1000202161 Allow other metrics to work if UDM xml is incorrect. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000202161

QXCR1000283795 Don't log error if metric ID or version is missing. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000283795

QXCR1000239027  Disallow user to configure both GRAPH_SERVER and GRAPH_URL. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000239027

QXCR1000238523 Eliminate RMID stop/start browser message. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000238523

 

Fixes with Version A.4.00 

CR NUMBER DESCRIPTION 

QXCR1000210529  Document WebLogic 6.1 SP1-SP6 JMX bug affecting servlet metrics. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000210529

QXCR1000223431 Document need to configure max values for metrics 251 ad 252. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000223431

QXCR1000212122 Missing PASSWORD causes NullPointerException. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000212122

QXCR1000215834  Discovery does not encode password. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000215834

QXCR1000214217  Add all available $OPTION() variables to reference manual. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000214217
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QXCR1000213844  wasspi_wls_perl.cmd fails on windows. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000213844

QXCR1000208609  Some WLSSPI reports reference "reporter.dbo." 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000208609

QXCR1000226129  JMX errors if consecutive collections span an app server restart. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000226129

QXCR1000216967 Intermittent collector hangs on hpux 11.00. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000216967

QXCR1000210784 TransformationException running servlet ascii reports (240,242,245). 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000210784

QXCR1000210300 WebLogic SPI does not load graph in browser when use OVPM 5.0. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000210300

QXCR1000137003 ddflog hang causes collector hang which causes template hang. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000137003

QXCR1000158547 Host name problem in service map. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000158547

QXCR1000158443  Login and password config properties should be required not conditional. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000158443

QXCR1000134785  Negative return value for WLS metric 251 and 252. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000134785

QXCR1000158620  status check uses name not alias so not all servers checked. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000158620

QXCR1000226129 JMX errors if consecutive collections span an app server restart. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000226129

QXCR1000236641  Collector trace broken on windows 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000236641

QXCR1000238519  Metrics - Server status value for reporting should not be 1 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000238519

QXCR1000244041  AttributeFilter include types should be OR'd 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000244041

QXCR1000283927  Bug in wasspi_wls_discovery.pl cause Service Creation not to work 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000283927

QXCR1000243711  Discovery fails on Windows after 7.30 patch is installed. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000243711

QXCR1000282418  WLSSPI A.03.50 -  wls.log growing very fast, causing filesystem full 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000282418

QXCR1000236250 Metric 270 has the wrong algorithm 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000236250

QXCR1000280751  Discovery not working if the domains is  in a different directory 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000280751

QXCR1000282761  'C:\PROGRA~1\HP ' is not recognized as an internal or external command 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000282761

QXCR1000281146  Trailing whitespace chars in server name breaks ascii reporting. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000281146
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QXCR1000298097 WebLogic Application Servers embedded in PeopleSoft Not Discovered 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000298097

QXCR1000237420  collector cmd-line cannot handle argvs with spaces 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000237420

QXCR1000281719  -S arg not needed in wasspi_xxx_DiscReg.txt 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000281719

QXCR1000291523  JMX ASCII reports formats all numbers as floats 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000291523

QXCR1000299107  Update SPI error message WASSPI-18 in docs. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000299107

QXCR1000224237  Document rmid related properties. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000224237

QXCR1000219069  Update JBoss JMX connector registration instructions for 4.0.1 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000219069

QXCR1000235586  logdata script logic error - does not remove lock 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000235586

QXCR1000285945  Need to workaround multiple registry Sun bug 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000285945

QXCR1000288197  Default templates collect from JMX Connector servers 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000288197

QXCR1000296585  Problem viewing OVPM graphs if there are spaces or special characters in the URL 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000296585

QXCR1000205496  UDM guide corrections 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000205496

QXCR1000243792  UDM graph disable is broken 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000243792

QXCR1000205134  Start Tracing app fails on Unix HTTPS node 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000205134

QXCR1000282756  Configure and Discovery Fails when Windows Short Path Name Creation is 
disabled 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000282756

QXCR1000281720  Filenames in message templates/policies must have double quotes 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000281720

QXCR1000247470  Collector not closing errorlog following write. 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000247470

QXCR1000237949 Discovery fails to update local SiteConfig if multiple srv have same name 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000237949

QXCR1000206584  UDM Graph Enable fails to create datasource on OVPA 4.0 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000206584

QXCR1000233473 Using the Start/Stop Monitoring SPI application causes metrics collector to fail 
http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000233473
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Known Problems, Limitations, and Workarounds 

• Problem: In a non-English environment, the message browser does not display error messages 
correctly. 

Workaround:  Change the character set of the WLSSPI Error Log template and redeploy the template. 
For example, change the character set from “Shift-JIS” to “Japanese EUC.” 

• Problem: When multiple managed nodes are selected when running the Discover WebLogic or 
Configure WebLogic applications, or if the Discover WebLogic and Configure WebLogic applications are 
run at the same time, the SPI may report errors for one or more selected managed nodes because the SPI 
configuration file (SiteConfig) for one or more managed nodes has been misplaced. (QXCR1000306403: 
Discover/Configure application may misplace the SPI configuration file on a managed node.) 

Workaround:  Run the Configure WebLogic application for each managed node that is reporting errors 
(run the application on each managed node one at a time). 

• Problem: The perl installed with the OVO agent fails to find the OVO perl modules if another 
application (such as Oracle Application Server) sets the PERL5LIB environment variable to point at 
locations that do not include the OVO perl lib location. (QXCR1000306217: WLSSPI Discovery fails for 
WLS version 7.0 on Windows 2003 HTTPS node.)   

Workaround 1: Set the PERL5LIB system environment variable: 

1 Prepend C:\Program Files\HP OpenView\nonOV\perl\a\lib (the OVO perl lib path) to the 
PERL5LIB system environment variable.  

2 Kill the OVO agent: opcagt -kill  

3 Restart the OVO agent: opcagt -start  

4 Check the OVO environment: ovdeploy -cmd set  

5 If the PERL5LIB variable is not set correctly in the OVO environment but the system variable is set 
correctly, reboot the system. 

Workaround 2:  

1 Delete the PERL5LIB system environment variable.  

2 Reboot the system. 

3 Run the Discover application. 

Workaround 3: Run the discover script on the target node. Enter the following: 

1 cd /var/opt/OV/bin/instrumentation 

2 wasspi_wls_perl –S wasspi_wls_discovery.pl 

NOTE: The service map is not generated when the discover script is run locally (is not run from the 
OVO management server). 

• Problem: The wls.log file grows very large (QXCM1000304720: Growing wls.log file).   

Workaround: Limit the size of the data saved to the log file each time the logfile encapsulator is run. In 
the SPIConfig file (located in /var/opt/OV/wasspi/wls/conf/ or /var/opt/OV/conf/wls/ on 
UNIX platforms and /usr/OV/wasspi/wls/conf/ on Windows platforms), add the following: 

# maximum number of lines to save to the log file / run 
LOG_LINE_LIMIT=16667 
# maximum number of characters to save from each log file / run 
LOG_SIZE_PER_FILE_LIMIT=600000 

 7 



• Problem: When using WebLogic Server 6.1, getAttributes returns a null value.   

Workaround:  Install WebLogic Server 6.1 sp7 (service pack 7). 

• Problem: On managed nodes using the DCE agent, the /var/opt/OV/wasspi directory and SiteConfig 
file are not created when running the SPI Discovery or Configuration applications.  The problem may be 
that the component opctranm may be hung.   

Workaround:  On the management server, run the following commands: 

ovstop ovoacomm 
rm –f /var/opt/OV/share/tmp/OpC/mgmt_sv/magmgr* 
ovstart opc 

• Problem: When the WebLogic Server is started, multiple WLSSPI-0011.1: % of execute threads used 
(<VALUE>%) too high messages are displayed in the message browser.  

Workaround:  These messages can be safely ignored when the WebLogic Server is being started.  

• Problem: When the Self-Healing Info application is run on a Windows managed node, the output file 
may be hidden. 

Workaround:  If you do not see the file, do the following on the managed node: 

1 Open Windows Explorer. 

2 From the Tools menu, select Folder Options.  

3 Click on the View tab.  

4 Under Hidden files and folders, select Show hidden files and folders. 

• Problem:  On a Solaris managed node, the ddflog and dsilog processes hang. The error message WASSPI-
1: Unable to create the lock file /var/opt/OV/wasspi/wls/datalog/ddflog.lck. File already 

exists. is reported and running the command ps –l shows that the ddflog_coda and ddflog or dsilog 
processes are hung. 

Workaround: On each Solaris managed node on which the problem occurs, do the following: 

1 In the /var/opt/OV/wasspi/wls/conf/SPIConfig file, set the DATA_LOGGING_EXECUTABLE_NAME 
property after the “#--------- Dynamic definitions -----------“ entry. DATA_LOGGING_EXECUTABLE_NAME 
explicitly sets the data logging program that is used (normally, the collector automatically 
determines the data logging program to use). 

If you are running OVPA, set the property to the following value: 

DATA_LOGGING_EXECUTABLE_NAME=/opt/perf/bin/dsilog 

If you are running CODA, set the property to the following value: 

DATA_LOGGING_EXECUTABLE_NAME=/opt/OV/bin/OpC/monitor/ddflog_coda 

2 Kill the hung ddflog_coda and ddflog or dsilog processes. 

Example excerpt from the SPIConfig file after setting the property: 

UDM_GRAPH_CAPACITY=50000 
UDM_PERF_CAPACITY=50000 
#--------- Dynamic definitions ----------- 
DATA_LOGGING_ENABLED=TRUE 
DATA_LOGGING_EXECUTABLE_NAME=/opt/perf/bin/dsilog 

• Problem: The "View Graphs" application does not work.  

Workaround:  On the OVPM Windows system, copy the file: 

\Program Files\HP Openview\newconfig\WLSSPI_Graphs.txt 

to: 

\Program Files\HP Openview\newconfig\VPI_GraphsWLSSPI.txt 
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• Problem: On Linux nodes, the "Configure SPI" or "Discovery" application can fail without configuring 
the SPI on the managed Linux node.  This happens because some of the configuration processes require 
uudecode to be present on the local node. 

Workaround:  Ensure that uudecode is installed on the target managed node.  It is available in the 
SHARUTILS package. 

• Problem: The "Start WebLogic" and "Stop WebLogic" applications fail on Windows nodes if the USER or 
SERVER<n>_USER configuration property is set.  The application is trying to run the "su" command, 
which is only available on UNIX. 

Workaround:  Do not set the USER or SERVER<n>_USER property when configuring the 
SERVER<n>_START_CMD or SERVER<n>_STOP_CMD properties for Windows nodes. 

• Problem: The SPI's configuration log …/wls/log/config.log on a managed node grows without 
being managed for size.  This file is appended to whenever the SPI's configuration is run, either 
manually or when the discovery process finds a change that requires configure to run (such as a 
WebLogic server being added or removed).  Unless there are frequent changes to the environment 
requiring reconfiguration, this should not be a problem. 

Workaround:  Manually delete the file if it gets too large. 

• Problem: WebLogic Server SPI cannot locate and therefore is unable to monitor the WebLogic log file 
when WebLogic Server is not started from the HOME directory.   This is only a problem in WebLogic 
Server 6.0 and 6.1. 

The location and name of the WebLogic Server log file is specified in the WebLogic Administration 
Console in the "Logging" tab on the server configuration page. If this log file is specified with a relative 
path, this path is relative to the directory in which the WebLogic Server is started. The default is the 
WebLogic home (WL_HOME) directory specified when the WebLogic SPI is configured. The startup scripts 
installed by BEA start WebLogic Server from its home directory.  

No means currently exists for querying the server for its startup directory.  So, if the WebLogic Server is 
started up in a directory other than WL_HOME and the log file is specified as a relative path, the WLSSPI 
may not be able to locate and monitor the WebLogic Server log file. 

Workarounds (choose either A, B, or C):  

(A) Configure the LAUNCH_DIR variable in the WebLogic Server SPI configuration file to define the 
location of the WebLogic Server startup directory. Please see Chapter 2 of the User’s Guide for details. 

(B) Ensure that WebLogic Server is started from the WL_HOME directory, which is the default if you use 
the startup scripts provided by BEA. Also, note that the WLSSPI will not recognize a fully qualified path 
name for the log file. You must use a relative path for the WebLogic Server log file in order for it to be 
located and monitored by the WLSSPI. 

(C) In the WLS-SPI configuration file, include the fully qualified name(s) of the WebLogic Server 
logfile(s) you want to monitor. For multiple logfile entries, separate each logfile name with a comma. 

To edit the file: 

1 Run the WLSSPI→WLSSPI Admin→Config WLSSPI application to edit the file.  

2 Insert an additional line beginning with keyword SERVER<n>_LOGFILE as shown below, followed by 
the fully qualified file name:   

SERVER<n>_LOGFILE = <path>/<file_name_1>,</<path>/<file_name_2>

3 Save the file and deploy to the node. 

NOTE: This workaround is an enhancement to the syntax as documented in the HP OpenView 
Operations Smart Plug-in for BEA WebLogic Server Configuration Guide.  
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• Problem: Two Netscape Navigator browser windows are launched when running the View Graphs 
application. The top window obscures the OVPM function buttons in the lower window.  

Workaround:  This problem only occurs with Netscape Navigator version 4.79. Use Netscape Navigator 
version 6.0 or higher. 

• Problem: The Web browser cannot be launched from an operator action after you have correctly 
configured the WLS-SPI as instructed in the “Configure the Management Server to Launch your Web 
Browser” task in chapter 2 of the HP OpenView Operations Smart Plug-in for BEA WebLogic Server 
Configuration Guide.  

Workaround:   

1 Stop and restart the agent from a user other than root by entering the following commands on the 
managed node: 

opcagt –kill 
opcagt –start 

2 Run the operator action.  

 

• Problem: Netscape fails to refresh graphing data. Specifically, when you use Netscape as the browser to 
graph your data (graphing capability included with Reporter 3.0 or higher), the browser fails to refresh 
when new selections are made.  

For example, in the OVO console after you drag and drop a managed node onto the WLSSPI Admin 
application View Graphs, Netscape appears and displays a blank WLS-SPI graphing page where you can 
accept or change the following default selections: 

Server:  MyServer_1 
Graph Name:  Serverstat 
Data Range: 7 Days (ending now) 

By clicking Draw, you successfully generate the graph.  

However, when you select a different server, let’s say MyServer_2, you see that the graph that appears 
after you click the Draw button is the same graph/data as the one you just viewed (for MyServer_1).  

Workaround: 

1 In Netscape from the Edit menu select Preferences→Advanced→Cache. 

2 In the segment labeled Document in cache is compared to document on network, select radio button 
Never. 

3 After successfully generating the first WLS-SPI graph, for any subsequent graphs, always change a 
minimum of two selections to refresh the data; for example select a different server and a different 
graph; or select a different graph and a different date range. Any two differing selections work to 
clear the current graph data from the browser cache. 

4 Note: The underlined text Refresh Graph Now at the bottom of the Web page does not work; when 
clicked, it may return the error: the parameter is incorrect. 

• Problem: For a managed node running Red Hat Linux 4 or Suse Linux 9.1 or 9.2, discovery and/or 
metric threshold monitor alarming is not functioning AND the following error message is found in the 
SPI error log: 

*** glibc detected *** double free or corruption: 0x0937d008 *** 

Workaround:  On the OVO agent, set the MALLOC_CHECK_ environment variable to 0 (zero) and restart 
the agent. 
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Support 
Please visit the HP OpenView support web site at:  

http://www.hp.com/managementsoftware/support   

This web site provides contact information and details about the products, services, and support that HP 
OpenView offers.   

HP OpenView online software support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As a valuable 
support customer, you can benefit by being able to:  

• Search for knowledge documents of interest  

• Submit and track progress on support cases  

• Submit enhancement requests online 

• Download software patches 

• Manage a support contract  

• Look up HP support contacts  

• Review information about available services  

• Enter discussions with other software customers  

• Research and register for software training  

NOTE: Most of the support areas require that you register as an HP Passport user and sign in. Many also 
require an active support contract.  

To find more information about support access levels, go to the following URL:  

http://www.hp.com/managementsoftware/access_level  

To register for an HP Passport ID, go to the following URL:  

http://www.managementsoftware.hp.com/passport-registration.html 

Legal Notices 

©Copyright 2005, 2007 Hewlett-Packard Development Company, L.P.  

The information contained herein is subject to change without notice.  

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.  
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